# Table of Contents

1. Introduction .................................................................................................................. 1
2. Locate and Start Program ............................................................................................... 2
   2.1 Locate PowerTeacher ................................................................................................. 2
   2.2 PowerTeacher ........................................................................................................... 3
   2.3 Parent Portal ............................................................................................................ 3
3. Grading System .............................................................................................................. 4
   3.1 Using PowerTeacher Pro ......................................................................................... 4
   3.2 Accessing the Gradebook ....................................................................................... 4
   3.3 Viewing and Adding Class Descriptions ................................................................. 5
   3.4 Setting Up Display Preferences ............................................................................... 5
   3.5 Setting Up Grading Preferences .............................................................................. 6
   3.6 Creating Categories ............................................................................................... 8
   3.7 Working with Grades ............................................................................................. 9
   3.8 Using the Score Inspector and Flags ...................................................................... 10
   3.9 Filling Scores ........................................................................................................ 11
   3.10 Marking Grades and Assignments ......................................................................... 12
   3.11 Working with Final Grades .................................................................................. 13
   3.12 Recalculating Final Grades .................................................................................. 14
4. Assignments .................................................................................................................. 15
   4.1 Creating Categories ............................................................................................... 15
   4.2 Creating and View Assignments .......................................................................... 16
   4.3 Adding Comments to Assignments/Grades ............................................................. 18
5. Attendance .................................................................................................................. 19
   5.1 Taking Daily Attendance ...................................................................................... 19
6. Lunch Count .................................................................................................................. 20
   5.1 Taking Daily Lunch Count .................................................................................. 20
7. Data Reports ................................................................................................................ 21
   7.1 Viewing Individual Student Progress .................................................................. 21
   7.2 Analyzing Class Progress ...................................................................................... 24
   7.3 Viewing Standards Grades Progress .................................................................... 25
   7.4 Running PowerTeacher Pro Reports ................................................................. 27
8. PowerSchool App ....................................................................................................... 30
9. Technical Support ....................................................................................................... 32
10. Notes ....................................................................................................................... 33

---

### Acknowledgement:

Special Thanks to Kirstin Wachter for compiling this guide especially for the Teachers in the Artesia Public Schools.

---

Copyright © 2005-2016 PowerSchool Group LLC and/or its affiliate(s). All rights reserved. All trademarks are either owned or licensed by PowerSchool Group LLC and/or its affiliates.
Introduction:

PowerSchool

With over 65 million users, PowerSchool is an innovative technology platform that streamlines, operations, removes inefficiencies, improves resource management, and frees more time for classroom instruction. It provides valuable insights into operations and classroom performance, empowers teachers, and drives student growth.

Highlights

- Unify the classroom experience
  - Full capabilities for attendance, grading, content, assignments, behavior, assessments, and collaboration
- Empower with data
  - Data analysis reveals trends to help tie curriculum to assessments, helps improve instruction and performance, and identifies weaknesses in units
- Drive student growth
  - Achieve measurable, tangible results in student performance and improve learning outcomes for individual students, classes, school and district
- Build student & parent engagement
  - Open effective avenues for communication with parents and students to foster learning that extends beyond the classroom

Outcomes

The goal of this training manual is to make it easier for school employees to navigate through the new PowerSchool system. Teachers will be able to access information with ease, and will no longer need to endure a difficult training course.
2. Locate & Start Program:

- 2.1 Use the following link to locate your PowerTeacher website:
  - https://bulldogs.powerschool.com/teachers/

- Your administrator will provide your username and password. From here you will be able to access all programs that are offered to teachers. If you wish to change your password, complete the following steps:
  - Start page
  - Personalize
  - Change password
• **2.2 Teachers use PowerSchool and PowerTeacher Pro:**
  - [http://bulldogs.powerschool.com/teachers](http://bulldogs.powerschool.com/teachers)
    - Take Attendance
    - Access student information
    - Communicate to families and administrators
    - Access gradebooks
    - Print Reports

• **2.3 Parents and Students use Student & Parent Portal:**
  - [http://bulldogs.powerschool.com](http://bulldogs.powerschool.com)
    - View attendance data
    - View assignments and grades
    - Read teacher comments
    - View daily bulletins
3. Grading System:

3.1 Using PowerTeacher Pro:

PowerSchool's new gradebook, PowerTeacher Pro, is a robust classroom management tool that includes advanced features for both standards-based and traditional grading. Teachers use the mobile-friendly gradebook to get their work done and to analyze student performance.

3.2 Accessing the Gradebook:

Teachers navigate to the HTML-based gradebook directly through the teacher portal. There’s no need to launch a separate application to access the gradebook. The first time you navigate to the gradebook, you'll see a welcome message that introduces some of the features.

- To navigate to the gradebook:
  1. Enter bulldogs.powerschool.com/teachers
  2. Enter your username and password
  3. Click “Sign In” or press “Enter”
  4. On the Start Page, click “PowerTeacher Pro” (located in the column on the left side of the page)
  5. Read the welcome message and click “Close”.
  6. To view the message again, click the Help icon (Question mark in the upper right-hand corner) and select “Getting Started”.

Notes:

Grading System
3.3 Viewing and Adding Class Descriptions:

The gradebook includes view-only details about each class you teach, such as the course name, course number, section number, period, term, start date, end date, and associated grade scale. Add more details about the class, such as a description or the syllabus, that will be visible in the PowerSchool Student and Parent Portals, and in PowerSchool Mobile.

- To add a class description:
  1. At the top of the gradebook window, select a class
  2. In the upper-right corner, select the term in which the class meets, if different from the current term
  3. Click Settings
  4. Select Class Descriptions. The details pane for the selected class opens.
  5. Enter the class description, syllabus, or other details in the Description field
  6. Click the arrow to the left of another class name to open the details pane and add a description
  7. Click Save

3.4 Setting Up Display Preferences:

Customize the display settings to control how class names appear in your gradebook—by period and day, by section number, or alphabetically. Additionally, define whether to show standards and traditional grades.

- To set up display preferences:
  1. Click Settings
  2. Select Display Settings
  3. Open the "Display and Sorting" menu and select an option, such as Section Number (sort by Course Name), to change the way class names appear
  4. Check Show Traditional Grades to display traditional grades in the gradebook
  5. Then from the "Values to Show in the Traditional Grade Column" menu, select the types of grades you want to see, such as Grade, Percent, and Points
  6. Check Show Standards Pages and Links to use the standards grading features in the gradebook
  7. Check Show Standards on Assignments to show standards aligned to assignments in the gradebook
8. To make the auto-calculation of standards scores from assignments scores the default setting when you create a new assignment, choose New Assignments Start Checked from the “Auto-Calculate Assignment Standards Scores Initial State” menu. Making this selection will cause the “Auto-Calculate Assignments Standards Scores” check box to be selected by default when you create an assignment. To view the setting when creating a new assignment, navigate to the Standards tab, select the standards that are aligned to the assignment, and click the Show Selected Standards tab.

9. To change the sort order of the Traditional and Standards navigation links in the Grading menu and Quick Menu, open the Navigation Links Sort Order menu and choose Standards, Traditional (The default setting is Traditional, Standards.)

10. To display the Professional Judgment Indicator on the Standards and Standards Progress pages, check Show on Grading: Standards and Show on Students: Standards Progress.

11. Under Student Names, use the Display menu to define how students’ names will appear in the gradebook, such as by first, then last name.

12. Use the “Sort Students by” menu to choose how to sort the lists of students, such as by first name.

13. To view new students’ names at the bottom of class lists, check Add newly enrolled students to the bottom.

14. To conceal the names of pre-registered students from class lists, check Hide pre-registered students.

15. Click Save.

3.5 Setting Up Grading Preferences

Administrators may choose to set up the grading preferences at the district or school level for all teachers. However, if they are permitted to do so by their district and school leaders, teachers may define some of the grade calculations for the classes they teach.

- To define a traditional grade calculation for a class:
  1. Click Settings
  2. Select Traditional Grade Calculations
  3. To see the grade calculations for all classes, click Expand All
  4. For one of the classes in the list, click the Edit icon next to the first reporting term.
5. To calculate the overall class grade using the formula, verify that Calculate Overall Class Grade is checked
6. Open the Type menu and choose a calculation type, such as Category Weighting
7. Open the Attribute menu and select a category, such as Homework
8. To define the weight of the selected category, enter a value in the Weight field, such as 2 (for 20%)
9. To include another category, click the + sign
10. Open the Type menu and choose Category Weighting
11. Open the Attribute menu and select a different category, such as Quiz
12. To define the weight of the selected category, enter a value in the Weight field, such as 3 (for 30%)
13. Repeat steps 9-12 to set up weighting for two more categories Use weight values that will make the values in the Percent columns add up to 100%
14. To save the grade calculation, click Save Set up the grade calculations for the remaining reporting terms. If you do not have access to edit the grade calculation preferences, follow your school and district policies or contact your PowerSchool administrator.

- To define standards grade calculations:
  1. Click Settings
  2. Select Standards Grade Calculations
  3. Define how standards grades will be calculated from assignment scores by default, for example, choose Most Recent Scores
  4. Define the number of recent scores to include in the calculation and their relative weighting by clicking the edit icon, choosing the number of scores, and modifying the values in the Weight column
  5. To automatically calculate higher-level standards grades from lowest-level standards grades, check Auto-Calculate
  6. Select the metric that will be used in the calculation, such as Mean
  7. Click Save.

3.6 Creating Categories

Categories are broad classifications in which you group similar types of assignments. Examples of categories are homework, tests, and quizzes. Set up your own categories, or use district-created categories. District-created categories are identified by an icon that looks like a school house next to the category name.
To create an assignment category:

1. Click Create
2. Select Category
3. On the Category tab, open the Select Classes menu and select the class or classes in which you will use the category
4. Enter the name of the category, such as Test
5. Select a color for the category, such as Red
6. Use the default status of Active Check Inactive when you want to make categories that you no longer use inactive.
7. Enter a description of the category, such as Use for test assignments
8. Click the Assignment Defaults tab
9. Select the default score type that assignments in this category will use, such as Points
10. To include extra points in the assignments by default, click Extra Points and enter the number of extra points, such as 5
11. To weight assignments in this category by default, click Weight and enter a value, such as 2, in the Weight field
12. In the Score Entry Points field, enter the number of points that assignments in this category will be worth by default, such as 100
13. To include assignments in this category in final grade calculations by default, verify that Count in Final Grade is selected
14. To save the new category, click Save
### 3.7 Working with Grades

When entering scores, make sure to use the type of score that you set up when you created the assignment. For example, use numbers for points and percentages or letters for letter grades.

- **To enter scores:**
  1. Click Grading
  2. Click Assignment List or Scoresheet
  3. From the Assignments or Scoresheet pages, enter a student’s assignment score by clicking in the cell where the student’s name intersects with the assignment name and type in the score

View the summary above the list of assignments to see the selected assignment’s score type, as well as the student’s existing score (if the assignment was previously scored), and the due date. In the summary, click Edit Assignment to edit the assignment details. Click Show More to view additional information, such as the associated grade and special codes scales.
3.8 Using the Score Inspector and Flags

While you can enter scores manually, use the Score Inspector to provide more details about the student’s performance, such as when a student has a missing or late assignment. Also use the Score Inspector to enter a comment about a student’s score.

Your district leaders may have associated a special codes scale to the regular grade scale. If that is the case, you can click Codes in the Score Inspector and select a special code, such as INC, to score a student’s assignment. In some cases, you may also see other system-generated icons that are related to standards grades.

To open the Score Inspector, click in a score cell on the Assignments or Scoresheet pages.

The following table provides brief explanations of the flags (score indicators) and other icons available in the gradebook.

<table>
<thead>
<tr>
<th>Flag or Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Indicates that an assignment was collected</td>
</tr>
<tr>
<td>🔒</td>
<td>Indicates that an assignment is late</td>
</tr>
<tr>
<td>⚠️</td>
<td>Indicates that an assignment is missing</td>
</tr>
<tr>
<td>🎯</td>
<td>Indicates that an assignment is exempt</td>
</tr>
</tbody>
</table>
3.9 Filling Scores

Use the Fill Scores functions to either fill scores for one assignment for all the students in a class, or to fill all assignment scores for one student. Scores will be filled in cells that do not already have scores. Additionally, use the fill scores functions to fill comments.

- To fill students’ scores for one assignment:
  1. For the selected assignment, click in a score cell on the Assignments or Scoresheet pages
  2. Enter the score or select the flag in the Score Inspector
  3. Click the Fill icon with the vertical arrows
  4. Click Save

- To fill multiple assignment scores for one student:
  1. For the selected student, click in a score cell on the Assignments or Scoresheet pages
  2. Enter the score or select the flag in the Score Inspector

Notes:

<table>
<thead>
<tr>
<th>Flag or Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Flag" /></td>
<td>Indicates that an assignment wasn’t completed due to the student being absent</td>
</tr>
<tr>
<td><img src="image" alt="Flag" /></td>
<td>Indicates that an assignment is incomplete</td>
</tr>
<tr>
<td><img src="image" alt="Flag" /></td>
<td>Indicates that a comment was added</td>
</tr>
<tr>
<td><img src="image" alt="Flag" /></td>
<td>Indicates that evidence exists for mastery that may differ from a student’s calculated standard score</td>
</tr>
<tr>
<td><img src="image" alt="Flag" /></td>
<td>Indicates that the standard grade is auto-calculated from the lower-level standards scores</td>
</tr>
<tr>
<td><img src="image" alt="Flag" /></td>
<td>Indicates that the assignment score is used to auto-calculate the scores for the standards aligned to the assignment</td>
</tr>
</tbody>
</table>
3. Click the Fill icon with the horizontal arrows
4. Click Save

3.10 Marking Grades/Assignments

Use one of two methods to score an assignment—score a single assignment from the Assignments page, or score multiple assignments on the Scoresheet.

- To enter scores, flags, or comments for a single assignment:
  1. Click Grading
  2. Select Assignment List
  3. Click the name of an assignment
  4. Click in a student’s score cell and type a score, such as 72. View the assignment summary above the list of students to see which score type to use.
  5. Click the Comment icon in the Score Inspector
  6. Enter a comment, such as Needs to turn work in on time
  7. Click the right-facing Score arrow in the Score Inspector to move to a standard score cell (if standards are aligned to the assignment)
  8. Enter a standard score for the student. View the assignment summary above the list of students to see which grade scale type to use.
  9. Click Save

- To enter scores, flags, or comments for one or more assignments on the Scoresheet:
  1. Click Grading
  2. Select Scoresheet
  3. Click in a student’s blank score cell for the selected assignment and enter a score in the Score Inspector
  4. Click the vertical Fill icon to fill all the blank score cells with the score you entered in the Score Inspector
  5. In the alert window that lists the number of scores that were filled, click Ok
  6. Click in a different student’s score cell for a different assignment and click the Exempt flag
  7. Click Save
When you delete or edit a score, the values in the student’s Course Grade column are grayed out because they are being edited. Once you click Save, the student’s grades will be recalculated using the new score.

### 3.11 Working with Final Grades

Final grades are updated automatically throughout the term as you enter assignment scores in the gradebook. When the term ends, you may have additional tasks to perform before submitting grades for report cards to make sure that your final grades are accurate. For example, you may have to enter standard grades and modify individual scores. Occasionally, you may also need to modify a student’s final grade in a course based on effort, participation, or other performance factors.

To work with final grades, click Grading and use the links in the Grades section. Access the same links through the Quick Menu—the arrow next to the heading at the top of the grading pages.

#### To modify a final grade:
1. Click Grading
2. Click Traditional
3. Click a student’s final grade
4. In the Score Inspector, edit the student’s grade. For example, change a letter grade of A- to A, and a percentage of 91 to 94.
5. Click Save
Notice that the student’s final grade cell has a small triangle in the upper-left corner, which indicates that the grade has been modified manually.

7. Open the Quick Menu and select Standards
8. Click a standard grade for the same student and edit it. For example, change a score of 3 to 4.

8. Click Save

*To revert to the calculated grade, click the Undo icon in the Score Inspector.

### 3.12 Recalculating Final Grades

Although final grades in PowerTeacher Pro are calculated automatically, you can force a recalculation, if necessary. Use the recalculate tool after making significant changes in the gradebook, such as adding multiple assignment scores for students who transferred from another class. Also, recalculate grades when your PowerSchool administrator changes a setting that affects the gradebook, such as the grade calculation formula.

- To use the recalculate tool:
  1. Click Settings
  2. Select Recalculate Final Grades
  3. Select the classes in which you are recalculating grades
  4. To recalculate traditional grades, check Traditional Final Grades
  5. To recalculate standards scores, check Standards Final Grades
  6. Click Recalculate
4. Assignments:

Working with Assignments

Before you begin creating assignments, it’s recommended that you create categories so you can group assignments by type. Then, set up assignments in the gradebook, choose whether or not to include them in the final grade, and tie them to standards. Your district leaders may also set up assignment categories at the district level for you and other teachers to use.

4.1 Creating Categories

Categories are broad classifications in which you group similar types of assignments. Examples of categories are homework, tests, and quizzes. Set up your own categories, or use district-created categories. District-created categories are identified by an icon that looks like a school house next to the category name.

To create an assignment category:
1. Click Create
2. Select Category
3. On the Category tab, open the Select Classes menu and select the class or classes in which you will use the category
4. Enter the name of the category, such as Test
5. Select a color for the category, such as Red
6. Use the default status of Active Check Inactive when you want to make categories that you no longer use inactive.

7. Enter a description of the category, such as Use for test assignments.

8. Click the Assignment Defaults tab.

9. Select the default score type that assignments in this category will use, such as Points.

10. To include extra points in the assignments by default, click Extra Points and enter the number of extra points, such as 5.

11. To weight assignments in this category by default, click Weight and enter a value, such as 2, in the Weight field.

12. In the Score Entry Points field, enter the number of points that assignments in this category will be worth by default, such as 100.

13. To include assignments in this category in final grade calculations by default, verify that Count in Final Grade is selected.

14. To save the new category, click Save.

### 4.2 Creating and Viewing Assignments

View assignments on both the Assignments and Scoresheet pages. Set up assignments at the beginning of a school term or at any time during the term. To save time, copy existing assignments or create duplicates while creating a new assignment.

- To create an assignment:
  1. Click Create.
  2. Select Assignment.
  3. Open the Select Classes menu and select a class Click outside the Select Classes menu to close it.
  4. Enter the name of the assignment, such as Unit 1 Test.
  5. Select Test as the category.
  6. Select a score type, such as Points.
  7. Enter the number of score entry points, such as 80.
  8. To include the assignment in students’ final grades, verify that Count in Final Grade is selected.
  9. Enter the assignment due date the default due date is today’s date.
  10. Enter a description, such as This test covers all the topics in Unit 1.
  11. Click the Students tab.
  12. Verify that the assignment applies to all students. To apply the assignment to a selection of students, click Add/Remove Students. Then clear the check.
box next to the Filter area and check the boxes next to the selected students’ names.
13. Click the Standards tab
14. Select the standards that are aligned to the assignment
15. Click the Publish tab
16. Open the Publish Assignment menu and choose when to publish the assignment for students and parents
17. To publish students’ scores once you’ve scored the assignment, check Publish Scores
18. Click Save at the bottom of the Create window

*At this point, you could copy the assignment by clicking Duplicate at the bottom of the Create window or close the window by clicking X in the upper-right corner.

- To duplicate an assignment for use in another class:
  1. Click Grading
  2. Select Assignment List
  3. In the list of assignments, locate an assignment that you’ve already created and click the Edit icon
  4. Click Duplicate at the bottom of the Edit window
  5. Open the Select Classes menu, clear the check box next to the currently selected class, and choose a different class. Click outside the Select Classes menu to close it.
  6. Enter the assignment name, such as Unit 1 Test
  7. Use the same category, score type, score entry points, due date, description, and publication settings as the original assignment, or modify the values as needed
  8. Click the Standards tab
  9. Click Add/Edit Standards and, if needed, select a new set of standards that are aligned to this assignment
  10. Click Save and close the Edit window
  11. To verify that you copied the assignment to a different class, click the name of the currently selected class in the navigation bar at the top of the page and select the class that you copied the assignment to
  12. Locate the duplicated assignment in the list of assignments

4.3 Adding Comments to Assignments/Grades
As you enter scores or flags for assignments, use comments to record specific details about student performance. Add comments manually or choose comments from the comment bank. Click the star next to a comment in the bank to set it as one of your favorite comments. Use smart text, such as or, to personalize comments.

- To add a comment:
  1. Click the Comment icon in the Score Inspector
  2. Either enter a comment in the text box, or click Comment Bank and select a comment A Blue Comment icon appears in the student’s score cell.
  3. Click Save
  4. Click the icon to read the comment
5. Attendance:

5.1 Taking Daily Attendance

Recording Attendance:
Login to PowerSchool:  [http://bulldogs.powerschool.com/teachers](http://bulldogs.powerschool.com/teachers)

An attendance indicator icon “A” appears next to each class. The color of the dot indicates whether or not you’ve taken attendance for that class.

Click the chair icon “B” next to the class for which you want to take attendance.

1. Choose either “Unexcused Absence” or “Unexcused Tardy” from the Current attendance code popup menu. Teachers will only record “Unexcused Absence” and “Unexcused Tardy.” The office will make the necessary changes to excuse absences and tardies.
2. Click the cell next to each student who is absent or tardy to insert the code you chose from the pop-up menu.
3. Click Submit.
6. Lunch Count:

At the “Start Page” at http://bulldogs.powerschool.com/teacher, click on the “Knife and Fork” icon “C”.

Simply record the number of students eating breakfast and students and adults eating lunch. Your building administrator will give directions as to when this should be done.
7. Data Reports:

Analyzing Performance

Use the gradebook to analyze student performance at any time during the school year. Analyze performance throughout the term to ensure that students are mastering the skills and standards that you are teaching. Review students' performance as you prepare to complete final grades for report cards, and then use the gradebook to prepare for and conduct parent-teacher conferences. Review how students in an entire class are performing using the Progress pages. The individual student pages provide helpful information during parent-teacher conferences to explain why a student earned a grade.

7.1 Viewing Individual Student Progress

- To review an individual student's performance:
  1. At the top of the gradebook window, select a class
  2. Click Students
  3. To view the first student's performance, click Assignments
  4. Review the student's course grades and individual assignment scores, then open the Quick Menu and select Standards Progress
  5. Review the student's standards scores for each reporting term, then click the Assignments icon for one of the standards
  6. Review the graph of standards scores, then click Show Metrics to review the student's other standards statistics

7. Click Students and select a different student to view his or her Standards Progress page. Here are the definitions of the standards scores statistics that are visible when you click Show Metrics below the graph:

  - Most Recent – The average of the most recent score(s)
- Mean – The mathematical average of the scores
- Median – The middle of the scores (half of the scores are above this number and half are below)
- Mode – The most common score achieved
- Weighted Mean – The average of the scores based on the average of total weighted points
- Highest – The highest score
- These statistical values are indicators of how well the student did on a specific standard. If any of the values are low, it may mean that the student needs additional practice on the skill or concept that you’re assessing, or you may need to revise the assignment. To view the student’s performance on additional standards, open the Quick Menu and select a standard.
- The orange Professional Judgment Indicator may appear next to a student’s standard score on the Standards Progress page when evidence exists for mastery that may differ from the student’s calculated standard score. To evaluate the student’s level of mastery, click the Assignments icon next to the standard score.

![SPEARS, Armstrong - Standards Progress](image)

- Use your professional judgment to evaluate whether or not the calculated score is a true indication of the student’s level of mastery. For example, if the student was ill or had a bad test day, his last score may not be a true indicator of his skill level, so you could choose to
ignore that score and change the calculated score from a 2- to a 2.

- To compare a student's progress on up to four standards, click the Settings icon next to the term menu on the Standards Progress page. In the Progress Options window, select the standards you want to include in the comparison and click OK. Then, click the Show/Hide Graphs icon next to the Settings icon to view the student's progress on all of the selected standards. Click one of the symbols, such as a triangle, on one of the line graphs for a different standard to highlight it and view the scores. Below the graph, view the calculated standard grades, the metrics, the aligned assignments, and the scores for the standards included in the comparison.

### 7.2 Analyzing Class Progress

Copyright © 2005-2016 PowerSchool Group LLC and/or its affiliate(s). All rights reserved. All trademarks are either owned or licensed by PowerSchool Group LLC and/or its affiliates.
To analyze the performance of an entire class, begin by selecting the class at the top of the gradebook window. Then, click Progress. Depending on how the gradebook is set up, you can view class progress on traditional grades and standards grades. Viewing Traditional Grades Progress:

- To view traditional grades progress:
  1. From the Progress menu, select Traditional
     1. The graph on the Traditional Grades Progress page shows the distribution of grades for the class for the selected reporting term. To the right of the graph, view a summary of the total number of students who have missing, late, or incomplete assignments.

2. Click the graph to open the Traditional Grades Distribution window
3. On the left side of the Traditional Grades Distribution window, view the score distribution for each reporting term in the school year
4. On the right, view the grade trends of the students in the class for the selected term, compared to the previous term. A red arrow in the Grade column indicates that the student’s grade is trending down between the selected terms. A green arrow indicates an upward trend, while no arrow indicates no change. You can see which students are performing better or worse between terms. (Continued on next page)

5. To compare trends between a different selection of subsequent terms, click a term in the Grade Distribution column.
6. To close the window, click X in the...
7.3 Viewing Standards Grades Progress

- To view standards grades progress:
  1. From the Progress menu, select Standards
     i. The graph on the Standards Progress page shows the distribution of grades for each standard aligned to the course, for the selected class and reporting term.
  2. Click the graph to open the Standard Grades Distribution window
  3. On the left side of the Standard Grades Distribution window, view the score distribution for the selected standard for each reporting term in the school year
4. On the right, view the grade trends of the students in the class for the selected term, compared to the previous term. A red arrow in the Grade column indicates that the student’s level of mastery is trending down between the selected terms. A green arrow indicates an upward trend, while no arrow indicates no change.

5. To compare trends between a different selection of subsequent terms, click a term in the Grade Distribution column

6. To close the window, click X in the upper-right corner.

On the right side of the Standards Progress page, the number in the Assignments column indicates the number of assignments that you’ve used to give students opportunities to practice the standard or to assess their levels of mastery.

- To view the assignments aligned to a standard:
  1. Click the Assignments icon next to a standard
  2. On the Standards Assignment Trend window, click the name of an assignment
  3. If needed, edit students’ scores in the column for the selected standard and click Save

7.4 Running PowerTeacher Pro Reports
The gradebook contains reports that you can view onscreen or print. Personalize each report by entering a custom title or by including a top note, bottom note, or signature line. The following table provides brief descriptions of the reports:

- To run the Individual Student Report:
  1. Click Reports
  2. Select Individual Student Report
  3. Enter a report title, such as Progress Report
  4. Open the Select Classes menu and choose the classes to include on the report
  5. In the Sort Options section, open the Layout menu and choose By Section, By Student
  6. To sort the report by students’ last names, open the Students menu and choose Last Name
  7. Open the Areas to Include menu and check Course Grade Comments and Assignment Comments to include any comments that you’ve entered about the students in the report "Course Grades and Attendance," Assignments, and Category Totals are checked by default.
  8. Click the Areas to Include menu again to close it
  9. Verify that Show Percentages is selected to include students’ grade percentages in the report
  10. To include students’ grades from the current term, use the default settings under Date Range
  11. Use the default settings under Data Filters to include any assignments, any scores, any category, and any course grades
  12. Open the Students tab
  13. To run the report for a selection of students rather than for all of the students in the classes, click Add/Remove Students
  14. All the students are selected by default, so clear the check box to the right of the Filter area, then in the list of students, check the boxes next to individual student’s names
  15. Scroll to the top of the page and click the Format tab
  16. Since you are including all the available data in the report, leave the page orientation set to Landscape to make the text easier to read
  17. Use the default option PDF for the report output
  18. To create a page break between students, check Page Break
  19. Choose to exclude row shading to save ink during printing

Notes:
20. Leave the “Include” check box clear for the Top Note option, since you don’t plan to include a note at the top of the report
21. Leave the “Include” check box clear for the Bottom Note option, since you don’t plan to include a note at the bottom of the report
22. Clear the Signature Line check box, since you don’t need parents to sign the report
23. To generate the report, click Run Report

- To run the Student Roster report for a class:
  1. Open the menu at the top of the gradebook window and select a class
  2. Click Reports
  3. Select Student Roster
  4. Enter a report title, such as Field Trip Roster
  5. Since you selected a class before you navigated to the Reports menu, it is already selected for the Classes option
  6. To sort the roster of students by last name, open the Students menu and choose Last Name
  7. Add columns of student information by opening the Add Columns menu and clicking Add next to Gender and Grade Level
  8. Click Add next to Blank twice to include a column for taking attendance and one for tracking participation. A column titled “Name” is included by default to list the students’ names.
  9. Click the Add Columns menu again to close it
  10. Enter Attendance as the title of the first blank column
  11. Enter Participation as the title of the second blank column
  12. Click the Students tab at the top of the page and verify that the report applies to all of the students in the selected class
  13. Scroll to the top of the page and click the Format tab
  14. Open the Orientation menu and choose Portrait
  15. Use the default option PDF for the report output. To work with the data in a spreadsheet, choose Excel.
  16. Use the default settings for the rest of the format options
  17. To generate the report, click Run Report
8. PowerSchool App:

Designed to better engage parents and students to increase student achievement, the free PowerSchool Mobile App creates awareness of student performance and opportunities for improvement on any mobile device. Students can hold themselves accountable and parents can stay apprised of grades, scores, performance, and attendance with real-time notifications, increasing home involvement with education and closing the learning gap.

*Use the following link to access printable parent flyer as seen above:

*Spanish version:

- See real-time updates on any device
Parents and students get insights, assignments, grades, and attendance

- **Receive instant communication**
  - Parents can receive emails and comments directly from the teacher’s Gradebook, and can quickly respond via email.

- **View all of your children in one parent account**
  - Parents and guardians can view all of their children’s information under one parent account, saving time and eliminating the need to repeatedly sign in and out to view each child’s updates.

- **Get push notifications with grades, attendance**
  - Users receive real-time notifications with updates about grades and attendance to help boost student engagement and growth through parent support.
9. Technical Support:

As a teacher, it is important to get the help you need when you need it. PowerSchool has an extensive library of help articles, resources, how-to’s, and more for you to empower yourself to find answer to your queries. For more technical issues, they have a support team of experts available.

- Customer Support Website:
  - https://www.powerschool.com/support/
- Training and Customer Education:
  - 877-873-1550 or Training@PowerSchool.com
- General Inquiries:
  - 877-873-1550 or sales@powerschool.com

PowerSchool Headquarters
150 Parkshore Dr.
Folsom, CA 95630
Fax: 916-596-0950
10. Notes: